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Safety and Compliance Information
In this section

This section includes:
• Instrument safety
• Safety and EMC standards
• Laser safety

Instrument Safety
In this section

This section includes:
•
•
•
•
•

Notes, Hints,
Cautions, and
Warnings

Notes, Hints, Cautions, and Warnings
Safety symbols
Before operating this instrument
Material Safety Data Sheets (MSDSs)
General Warnings

Notes, Hints, Cautions, and Warnings are used in this
document as follows.
A Note provides important information to the operator. For
example:
NOTE: If you are prompted to insert the boot diskette into
the drive, insert it, then press any key.
A Hint provides helpful suggestions not essential to the use of
the system. For example:
Hint: To avoid complicated file naming, use Save First to
Pass or Save Best Only modes.
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A Caution provides information to avoid damage to the system
or loss of data. For example:
CAUTION
Do not touch the lamp. This may damage the lamp.
A Warning provides specific information essential to the safety
of the operator. For example:
WARNING
CHEMICAL HAZARD. Wear appropriate personal
protection and always observe safe laboratory practices
when operating your system.

Remarques,
recommandations
et avertissements

Une remarque fournit une information importante à l’opérateur
er se présente ainsi:
REMARQUE: Si on vous demande d’insérer la disquette de
démarrage dans le lecteur, insérez-la puis appuyez sur
n’importe quelle touche.
Une recommandation fournit une information destinée à éviter
des détériorations du système ou la perte de données:
RECOMMANDATION
La lampe peut être endommagée. N’y touchez pas.
Un avertissement fournit une information indispensable à la
sécurité de l’operateur et se présente ainsi:
AVERTISSEMENT
Conformez-vous toujours aux règlements du laboratoire
quand vous utilisez votre système.
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Safety symbols

The following symbols may be displayed on the system.
These symbols may also appear next to associated warnings
in this document.

Electrical Symbols

The following chart is an illustrated glossary of electrical
symbols that may be displayed on your instrument. Whenever
such symbols appear on instruments, please observe
appropriate safety procedures.

This symbol indicates the on position of the main power switch.

This symbol indicates the off position of the main power switch.

This symbol indicates the on/off position of a push-push main
power switch.
This symbol indicates that a terminal may be connected to
another instrument’s signal ground reference. This is not a
protected ground terminal.
This symbol indicates that this is a protective grounding
terminal that must be connected to earth ground before any
other electrical connections are made to the instrument.

~

A terminal marked with this symbol either receives or delivers
alternating current or voltage.

~

A terminal marked with this symbol can receive or supply an
alternating and a direct current or voltage.
This symbol appears next to the values of the fuses required by
the system.
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WARNING: This symbol indicates the presence of high voltage
and warns the user to proceed with caution.
WARNING: This symbol alerts you to consult the manual for
further information and to proceed with caution.

Non-electrical
Symbols

The following is an illustrated glossary of non-electrical safety
alert symbols that may be displayed on your instrument.

WARNING: This symbol illustrates a heater hazard. Proceed
with caution when working around these areas to avoid being
burned by hot components.
This symbol indicates that a laser is present inside the
instrument.
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Symboles des
alertes de
sécurité

Les symboles suivants peuvent être affichés sur le système.
Dans ce document, ces symboles peuvent aussi apparaître à
côté des avertissements auxquels ils s’associent.

Symboles
électriques

Le tableau suivant donne la signification de tous les symboles
électriques qui figurent sur les appareils. En présence de l’un
de ces symboles, il est impératif de se conformer aux
consignes de sécurité appropriées.

Position MARCHE de l’interrupteur d’alimentation principal.

Position ARRÊT de l’interrupteur d’alimentation principal.

Positions MARCHE-ARRÊT de l’interrupteur d’alimentation
principal à bouton poussoir.
Borne pouvant être reliée à la mise à la terre d’un autre
appareil. Ce n’est pas une borne de mise à la terre protégée.
Borne de mise à la terre de protection devant être reliée à la
terre avant d’effectuer tout autre raccordement électrique à
l’appareil.

~

Borne recevant ou fournissant une tension ou un courant de
type alternatif.

~

Borne pouvant recevoir ou fournir une tension ou un courant
de types alternatif et continu.
Ce symbole apparaît à côté des valeurs des fusibles requis
par le système.
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AVERTISSEMENT: Indique la présence d’une haute tension
et avertit l’utilisateur de procéder avec précaution.
AVERTISSEMENT: Avertit l’utilisateur de la nécessité de
consulter le manuel pour obtenir davantage d’informations et
de procéder avec précaution.

Symboles non
électriques

Le tableau suivant donne la signification des symboles
d’alertes de sécurité non électriques qui figurent sur les
appareils.

AVERTISSEMENT: Danger associé à la présence d’un
appareil de chauffage. Procéder avec précaution pour éviter
de se brûler au contact de pièces ou d’éléments chauds.
Indique que l’appareil renferme un laser.

x

Applied Biosystems

Safety and Compliance Information

Before operating
this instrument

Ensure that anyone involved with the operation of the
instrument is instructed in both general safety practices for
laboratories and specific safety practices for the instrument.
Make sure you have read and understood all related Material
Safety Data Sheets.

Material Safety
Data Sheets
(MSDSs)

Some of the chemicals that may be used with your system are
listed as hazardous by their manufacturer. When hazards
exist, they are prominently displayed on the labels of all
chemicals. In addition, MSDSs supplied by the chemical
manufacturer provide information about:
•
•
•
•
•
•

Physical characteristics
Safety precautions
Health hazards
First-aid
Spill clean-up
Disposal procedures
WARNING

CHEMICAL HAZARD. Before handling any chemicals, refer
to the Material Safety Data Sheet provided by the
manufacturer, and observe all relevant precautions.

AVERTISSEMENT
RISQUE CHIMIQUE. Avant de manipuler des produits
chimiques, veuillez consulter la fiche de sécurité du
matériel fournie par le fabricant, et observer les mesures de
précaution qui s’imposent.
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To order MSDSs...
Over the Internet

Then...
Go to our Web site at www.pebio.com/techsupport.
Click MSDSs.
Enter keywords (or partial words), or a part number,
or the MSDSs Documents on Demand index
number.
Click Search.
Click the Adobe Acrobat symbol to view, print, or
download the document, or check the box of the
desired document and delivery method
(fax or e-mail).
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General Warnings

WARNING
FIRE HAZARD. Using a fuse of the wrong type or rating
can cause a fire. Replace fuses with those of the same type
and rating.

AVERTISSEMENT
DANGER D’INCENDIE. L’usage d’un fusible de type ou de
valeur nominale différents risque de provoquer un incendie.
Il convient donc de remplacer les fusibles usagés par des
fusibles du même type et de la même valeur nominale.

WARNING
LASER HAZARD. The laser emits ultraviolet radiation.
Lasers can burn the retina and leave permanent blind
spots. Do not remove any instrument panels or look directly
into the laser beam or allow a reflection of the beam to
enter your eyes. Wear proper eye protection if any panels
are removed for service.

AVERTISSEMENT
DANGER LASER. Le laser émet des radiations
ultraviolettes. Les lasers peuvent brûler la rétine et laisser
des points aveugles permanents. Il convient de ne pas
retirer le panneau avant ou les panneaux latéraux de
l’appareil et de ne pas regarder directement dans le
faisceau laser ou laisser une réflexion du faisceau entrer
dans les yeux. Portez des protections adéquates pour les
yeux si le panneau avant ou les panneaux latéraux ont été
retirés afin d’effectuer l’entretien.
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WARNING
ELECTRICAL SHOCK HAZARD. Severe electrical shock
can result by operating the instrument without the panels in
place. Do not remove instrument front or side panels. High
voltage contacts are exposed with front or side panels
removed.

AVERTISSEMENT
RISQUE DE DÉCHARGE ÉLECTRIQUE. Des décharges
électriques sérieuses peuvent résulter du fonctionnement
de l’appareil lorsque le panneau avant et les panneaux
latéraux sont retirés. Ne pas retirer le panneau avant ou les
panneaux latéraux. Des contacts haute tension sont
exposés lorsque les panneaux sont retirés.

WARNING
CHEMICAL HAZARD. To prevent eye injury, always wear
eye protection when working with solvents.

AVERTISSEMENT
RISQUE CHIMIQUE. Pour éviter les blessures aux yeux,
porter toujours des protections pour les yeux lorsque vous
manipulez des solvants.
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WARNING
PHYSICAL INJURY HAZARD. Use the Voyager
Biospectrometry Workstation only as specified in this
document. Using this system in a manner not specified may
result in injury or damage to the system.

AVERTISSEMENT
DANGER DE BLESSURES CORPORELLES.Veuillez
suivre avec attention les indications figurant dans ce
document lorsque vous utilisez la Station de Travail de
Biosptectrométrie Voyager. Un usage différent de la station
pourrait causer un accident ou endommager le système.
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Safety and EMC
(Electromagnetic Compliance) Standards
US Safety and
EMC
Standards

Safety
This instrument has been tested to and complies with
standard ANSI/UL 3101-1, “Electrical Equipment for
Laboratory Use; Part 1: General Requirements”, 1st Edition. It
is an ETL Testing Laboratories listed product.

EMC
This device complies with Part 15 of the FCC Rules. Operation
is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must
accept any interference received, including interference that
may cause undesired operation.
WARNING
Changes or modifications to this unit not expressly
approved by the party responsible for compliance could
void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to
comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference
when the equipment is operated in a commercial
environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of
this equipment in a residential area is likely to cause
harmful interference in which case the user will be required
to correct the interference at his own expense.
NOTE: Shielded cables must be used with this unit to
ensure compliance with the Class A FCC limits.
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Canadian Safety
and EMC
Standards

1

Safety
This instrument has been tested to and complies with
standard CSA 1010, “Safety Requirements for Electrical
Equipment for Measurement, Control, and Laboratory Use;
Part 1: General Requirements”. It is an ETL Testing
Laboratories listed product.

Sécurité
Cet instrument a été vérifié avec la norme CSA 1010,
«Spécifications de sécurité du matériel électrique utilisé pour
les mesures, les contrôles et dans les laboratoires ; Partie 1 :
Spécifications générales», et il est conforme à cette norme.
C’est un produit homologué par les ETL Testing Laboratories.

EMC
This Class A digital apparatus meets all requirements of the
Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les
exigences du Règlement sur le materiel brouilleur du Canada.

European Safety
and EMC
Standards

Safety
This instrument meets European requirements for safety
(EMC Directive 73/23/EEC). This instrument has been tested
to and complies with standard EN61010-1 “Safety
Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use”.

EMC
This instrument meets European requirements for emission
and immunity (EMC Directive 98/336/EEC). This product has
been evaluated to the EN55011:1992, Group 1, Class B
“Radiated Emissions”, and EN50082-1:1992, “Generic
Immunity”.

Voyager™ Biospectrometry™ Workstation Getting Started Guide

xvii

1

Safety and Compliance Information

Laser Safety
Laser
classification

The Voyager™ Biospectrometry™ Workstation uses a standard
nitrogen laser and an optional Nd:YAG laser. Under normal
operating conditions, the instrument laser is categorized as a
Class I laser. Under certain conditions during servicing, when
interlocks have been circumvented, the lasers fall into the
following categories (can cause permanent eye damage):
• Nitrogen—Class IIIb
• Nd:YAG—Class IV
The Voyager Biospectrometry Workstation complies with Title
21, U.S. Government DHEW/BRH Performance Standards,
Chapter 1, Subchapter J, Section 1040, as applicable.

Laser safety
features

The following safety features are included on the Voyager
Biospectrometry Workstation:
• Cabinet is designed to prevent access to collateral laser
radiation exceeding the accessible emission limits in
Performance Standards for Laser Products, 21 CFR
1040.10.
• Front and side panels have interlock switches that disable
the laser when panels are removed.
• Safety labels for Class I standards are affixed to the unit.

Laser safety
requirements

To ensure safe laser operation, note the following:
• The system must be installed and maintained by an
Applied Biosystems Technical Representative.
• All panels must be installed during operation. When all
panels are installed, there should be no detectable
radiation present. If any panels are removed when the
laser is operational, you may be exposed to laser
emissions in excess of Class 1 rating.
• Do not remove labels or disable safety interlocks.

Additional safety
information
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Refer to the users manual provided with the laser for
additional information on government and industry safety
regulations.
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1 Before You Begin

This chapter contains the following sections:
1.1

Introduction to the System ......................... 1-2

1.2

Running Your First Experiment ................... 1-4
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1 1.1 Introduction to the System
Basics of the
system

An Applied Biosystems Technical Representative will give you
a quick introduction to the following:
•
•
•
•

General computer
and software tasks

General computer and software tasks
Sample prep tasks
Acquisition tasks
Processing tasks

• Start the computer, start the Voyager software, restart the
computer by pressing Control+Alt+Delete, select Shut
down, then select Shutdown and Restart.
• Use Windows NT basic techniques.
• Use the mouse, click, click-drag, double-click. Use the
right mouse button.
• Use Window NT Explorer to create directories, copy files,
delete files, display file information.
• Use the Open File dialog box, double-click to display
lower level directories.
• Use Notepad to view text files.
• Resize windows.
• Change between tasks (press Alt+Tab or use the
Windows Task Manager).
• Change between programs.
• Open and close programs.

Sample prep tasks

• Prepare peptide samples in α-cyano matrix.
• Prepare peptide samples in sinapinic acid matrix.
• Load a sample plate.
• Clean a sample plate.
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Acquisition tasks

• Use the Instrument Control Panel.

1

• Use the Sequence Control Panel.
• Load, modify, and save instrument settings (.BIC) files.
• Use the software or control stick to change the x,y
position of the laser on the sample.
• Acquire and save data.
• Use the Spectrum window, describe key features.
• Use the oscilloscope, describe key features.
• Use the LSA1000 LeCroy® digitizer, describe key
features.
• Use the Acqiris® digitizer, describe key features.

Processing tasks

• Manipulate a trace using all toolbar buttons.
• Calibrate a spectrum and use the calibration in a .BIC file.
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1 1.2 Running Your First Experiment
Purpose

The Voyager ™ Biospectrometry ™ Workstation Getting Started
Guide is designed to help you quickly learn how to use the
Voyager Biospectrometry Workstation. It provides
step-by-step procedures for preparing and analyzing:
• A peptide standard containing Adrenocorticotropic
hormone, clip 7–38 [ACTH (7–38)], Adrenocorticotropic
hormone, clip 18–39 [ACTH (18–39)], and insulin
• A mock peptide sample containing the standard
component ACTH (7–38)

Assumptions

NOTE: This guide assumes that your Voyager Workstation
has been properly installed by an Applied Biosystems
Technical Representative and that the workstation vacuum
pressure is less than 10–6 Torr on Voyager-DE and
Voyager-DE PRO systems, or less than 5×10–7 on the
Voyager-DE STR system.

In this guide

This guide contains brief procedures. For more detailed
procedures and reference information, refer to the Voyager™
Biospectrometry™ Workstation User’s Guide.
In the following chapters, you will:
•
•
•
•
•

1-4

Applied Biosystems

Start up
Prepare samples
Acquire calibration standard spectra
Create a calibration (.CAL) file
Acquire sample spectra

Running Your First Experiment

What you need

To perform the experiment in this guide, you need:
• Sample plate with laser-etched sample positions or wells

NOTE: If you do not have a sample plate with laseretched sample positions or wells, you can use a
polished blank sample plate. If you use a polished blank
sample plate, load the sample directly under the
position number on the plate to ensure that the laser is
centered on the sample when you move to a sample
position.
• α-cyano-4-hydroxycinnamic acid (CHCA) matrix
• Adrenocorticotropic hormone, clip 7–38
[ACTH (7–38)], 50 pmol/µl in aqueous solution
• Adrenocorticotropic hormone, clip 18–39
[ACTH (18–39)], 50 pmol/µl in aqueous solution
• Bovine insulin, 50 pmol/µl in aqueous solution

WARNING
CHEMICAL HAZARD. Alpha-cyano-4hydroxycinnamic acid (CHCA) matrix may cause
eye, skin, and respiratory tract irritation. Read the
MSDS and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

WARNING
CHEMICAL HAZARD. ACTH and Insulin may cause
an allergic skin and respiratory reaction. Exposure may
cause eye, skin, and respiratory tract irritation. Please
read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and
gloves.
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1

NOTE: You can use the Calibration Mix 2 standard from the
Sequazyme ™ Mass Standards Kit which contains all of the
components listed above.
See the Voyager Biospectrometry Workstation User’s Guide,
Appendix B, Warranty/Service Information, for standard
ordering information.
To prepare matrix and sample, you need:
•
•
•
•
•
•
•
•
•

Analytical balance
1.5 ml microcentrifuge tubes
Microcentrifuge (optional)
Micropipettor and disposable tips
Vortex mixer
Deionized water
Acetonitrile
3% trifluoroacetic acid (TFA) in deionized water
Finely-tapered pipette tips for dispensing matrix and
sample solutions on sample plates
WARNING

CHEMICAL HAZARD. Please read the MSDS before
handling any chemical mentioned below, and follow the
handling instructions. Wear appropriate protective eyewear,
clothing, and gloves.
Acetonitrile is a flammable liquid and vapor. It may cause
eye, skin, and respiratory tract irritation, central nervous
system depression, and heart, liver, and kidney damage.
Trifluoroacetic acid causes severe burns to the eyes, skin,
and respiratory tract.
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2 Starting Up

This chapter contains the following sections:
2.1

Powering Up .......................................... 2-2

2.2

Starting the Software ....................................... 2-3

For more information, see the Voyager Biospectrometry Workstation
User’s Guide, Section 2.10, Startup and Shutdown.
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2.1 Powering Up
The Voyager mass spectrometer is typically powered up at all
times.
To power up the other components of the system:
1.

Turn on the following system devices in this order:
•
•
•
•
•

2
2.

Video monitor
External digitizer, if your system includes one
Oscilloscope, if your system includes one
Computer
Printer

If your system includes an oscilloscope, wait
approximately one minute for its initialization cycle to
finish. A message indicates that the power on self check
passed, then the oscilloscope screen is displayed. See
the Voyager Biospectrometry Workstation User’s Guide,
Appendix I, Using the Oscilloscope and Control Stick, for
more information.
If your system includes a LeCroy digitizer, wait
approximately one minute until the digitizer completes
its internal calibration before starting the Instrument
Control Panel.

3.
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Log on to the Voyager Workstation using your User Name
and Password. See your system administrator for your
User Name and Password.

Starting the Software

2.2 Starting the Software
Starting
Instrument
Control Panel

To start the Voyager Instrument Control Panel (Figure 2-1)
from the Windows NT desktop, double-click the Voyager
Control Panel icon on the desktop.

2

Figure 2-1 Instrument Control Panel

Initializing

The hardware is automatically initialized when you start the
Instrument Control Panel.
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Starting the Data
Explorer software

To start the Data Explorer software from the Windows NT
desktop, double-click the Data Explorer icon on the desktop.

2

Figure 2-2 Data Explorer Window with No Data

Menus are not displayed and toolbar buttons are not active
until you open a data file.
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3 Preparing Samples

This chapter contains the following sections:
3.1

Overview ............................................... 3-2

3.2

.....................................
Preparing Samples ..................................
Mixing Sample and Matrix .........................
Loading Samples on Sample Plates .............

3.3
3.4
3.5
3.6

Preparing Matrix

3-3
3-5
3-7
3-8

Loading Sample Plates
in the Mass Spectrometer ......................... 3-10

For a detailed description of preparing samples and matrix, see the
Voyager Biospectrometry Workstation User’s Guide, Chapter 3,
Preparing Samples.
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Preparing Samples

3.1 Overview
Guidelines for
successful
sample
preparation

To prepare samples, follow these guidelines:
• Prepare fresh matrix as needed. Some matrices require
daily preparation. Other matrices can be stored for up to
one week at room temperature.
• Determine the proper dilution of sample.
• Use clean sample plates.
• Properly apply sample and dry to allow good
crystallization.

Matrix stability

3

Additional
information
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Some matrices degrade upon exposure to light or humidity.
Some matrices require daily preparation. Other matrices can
be stored for up to one week at room temperature. Follow the
matrix manufacturer’s instructions for storage conditions of
chemicals.
Appendix C, Matrixes, in the Voyager Biospectrometry
Workstation User’s Guide, contains additional information on
matrix structure, appearance, and matrix solutions.

Preparing Matrix

3.2 Preparing Matrix
Matrix function

Selecting matrix

In MALDI-TOF MS (matrix-assisted laser desorption ionization
time-of-flight mass spectrometry), the matrix plays a key role
in the ionization process. The well-developed crystals of
matrix material assist in ionizing the biomolecules you are
analyzing.
As a general guideline, the molecular weight of the
peptide/protein you are analyzing determines the matrix to
use:
• > 10,000 Da—Sinapinic acid (3,5-dimethoxy-4-hydroxy
cinnamic acid)
• < 10,000 Da—α-cyano-4-hydroxycinnamic acid
Because the compounds you are analyzing have masses less
than 10,000 Da, α-cyano-4-hydroxycinnamic acid is the
appropriate matrix for this application.

Preparing

To prepare 10 mg/ml solution of α-cyano-4-hydroxycinnamic
acid (CHCA) matrix:
1.

Label a 1.5 ml microcentrifuge tube with the name of
the matrix, the final concentration, and the date
prepared.

2.

Weigh approximately 10 mg of the dry CHCA matrix and
add it to the tube.
WARNING
CHEMICAL HAZARD. Alpha-cyano-4hydroxycinnamic acid (CHCA) matrix may cause eye,
skin, and respiratory tract irritation. Read the MSDS
and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.
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NOTE: Use a fresh tip each time you pipette a different
substance.
3.

Add 400 µl deionized water, 100 µl 3% TFA, and
500 µl acetonitrile to the tube.
WARNING
CHEMICAL HAZARD. Please read the MSDS before
handling any chemical mentioned below, and follow the
handling instructions. Wear appropriate protective
eyewear, clothing, and gloves.
Acetonitrile is a flammable liquid and vapor. It may
cause eye, skin, and respiratory tract irritation, central
nervous system depression, and heart, liver, and kidney
damage.
Trifluoroacetic acid causes severe burns to the eyes,
skin, and respiratory tract.

3
4.

Cap the tube and vortex thoroughly for approximately
one minute. You can shake the tube by hand if you do not
have a vortex mixer.

5.

Microcentrifuge the tube for 30 seconds at
2,000 to 5,000 rpm. Alternatively, allow the solution to
settle for about 10 minutes. You may see a precipitate at
the bottom of the tube.
When you load matrix, use the supernatant, not the
precipitate.
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3.3 Preparing Samples
Preparing

Prepare a 50 pmol/µl solution of each of the following
components:
• ACTH (7–38)
• ACTH (18–39)
• Bovine insulin
WARNING
CHEMICAL HAZARD. ACTH and Insulin may cause an
allergic skin and respiratory reaction. Exposure may cause
eye, skin, and respiratory tract irritation. Please read the
MSDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

3

From these solutions you will create:
• Standard solution—Containing all three components
• Mock sample solution—Containing ACTH (18–39)
NOTE: Use preweighed vials of ACTH to ensure accurate
final concentrations. See the Voyager Biospectrometry
Workstation User’s Guide, Appendix B, Warranty/Service
Information, for standard ordering information.
To prepare 50 pmol/µl solutions of each component:
1.

Add 1.3 ml deionized water to a 250 µg vial of
ACTH (7–38).

2.

Add 4 ml deionized water to a 500 µg vial of
ACTH (18–39).
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3.

Weigh out 1 mg bovine insulin. Add 3.5 ml 0.1%
aqueous trifluoroacetic acid (TFA).
WARNING
CHEMICAL HAZARD. Trifluoroacetic acid causes
burns to the eyes, skin, and respiratory tract. Read the
MSDS and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

NOTE: Alternatively, you can prepare the Calibration Mix 2
sample from the Sequazyme Mass Standards Kit. Follow
the instructions listed in the kit to prepare a 50 pmol/µl
solution of Calibration Mix 2.

Storing

3

If you will not use the insulin within four hours, freeze it. If you
will not use the other samples within one day, freeze them.
You can aliquot and freeze unused stock solution for future
use.
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3.4 Mixing Sample and Matrix
Preparing
standard and
sample solutions

Mix standard or sample and matrix before loading on the
sample plate.
NOTE: You can alternatively mix sample and matrix on the
sample plate. However, when working with a concentrated
sample, or when preparing many samples, premixing
before loading on the sample plate is the preferred method.
To mix sample and matrix:

Standard solution

1.

Label two 1.5 ml microcentrifuge tubes with “Standard”
and “Sample” and the date prepared.

2.

To the “Standard” tube, add 22 µl of matrix solution. Add
matrix before sample to prevent sample from adhering to
the plastic tube.

3.

To the “Standard” tube, add the following (initial
concentration 50 pmol/µl for each component, for a final
concentration of 2 pmol/µl of each component):
• 1 µl ACTH (7–38)
• 1 µl ACTH (18–39)
• 1 µl Bovine Insulin

NOTE: Alternatively, you can add 1 µl of the prepared
50 pmol/µl CalMix 2 standard solution.

Sample solution

4.

Vortex for 15 seconds.

5.

To the “Sample” tube, add 24 µl of matrix solution.

6.

To the “Sample” tube, add 1 µl ACTH (7–38) (initial
concentration 50 pmol/µl, for a final concentration of
2 pmol/µl).

7.

Vortex for 15 seconds.
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3.5 Loading
Samples on Sample Plates
Handling sample
plates

To prevent contamination of your analysis:
• Start with a clean sample plate. See the Voyager
Biospectrometry Workstation User’s Guide, Section 3.3,
Cleaning Sample Plates.
• Handle the sample plate by the edges.

Guidelines for
good
crystallization

To ensure good crystallization:
• Fill the entire well when spotting the sample plate, if
possible. Surface tension and sample availability may
determine whether you fill the well completely.
• When using α-cyano-4-hydroxycinnamic acid, do not
touch the surface of the sample well with the pipette tip. It
may cause uneven crystallization.

3
Guidelines

Load one sample position (or well) with the standard, and one
with the sample.
NOTE: For optimum mass accuracy, place standards in
positions (or wells) adjacent to the samples for which you
are calibrating, and do not use the outer sample positions
(wells) on the sample plate.
Create a log sheet listing sample position and sample name.
Appendix D, Log Sheets, in the Voyager Biospectrometry
Workstation User’s Guide, contains master log sheets that you
can copy and use.
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WARNING

Loading samples

CHEMICAL HAZARD. Before handling any chemicals, refer
to the Material Safety Data Sheet provided by the
manufacturer, and observe all relevant precautions.
To load samples:
1.

Load 1 µl of standard/matrix and 1 µl of sample/matrix
in adjacent sample positions on the plate.

NOTE: Use a fresh pipette tip each time you pick up a
different substance.
2.

Allow the sample plate to dry for at least five minutes.

3.

Visually examine the sample spots to make sure they are
dry.

4.

Place a protective cover over the plate to prevent
contamination until you are ready to load the plate. Do not
allow the cover to touch the surface of the plate.
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3.6 Loading Sample Plates
in the Mass Spectrometer
NOTE: If you load the sample plate into the Voyager
Biospectrometry Workstation before the plate is dry, the
pressure in the sample chamber rises, and a “TC2 pressure
too high” error code may be displayed in the Instrument
Control Panel. Wait a few minutes for the chamber to reach
pressure.

Ejecting the
sample holder

In the Voyager Instrument Control Panel (see Figure 2-1 on
page 2-3), select Eject from the Sample Plate menu. The
Load/Eject Sample Plate dialog box (Figure 3-1) is displayed.

3

Figure 3-1 Load/Eject Sample Plate Dialog Box
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Click Eject. The following occurs:
• A Load/Eject Cycle Status dialog box is displayed during
the ejection sequence which displays hardware status.
• High voltage is turned off.
• The video monitor displays the sample plate moving.
• The sample holder moves out of the main source
chamber, out of the sample loading chamber, and is
ejected from the instrument.
NOTE: Do not leave the sample holder in the Eject position
for more than a few minutes. Minimize the time the
instrument is exposed to the atmosphere to reduce the time
needed to reach high vacuum when you insert a new plate.

Voyager-DE and
Voyager-DE PRO

To load sample plates:
1.

Eject the sample holder as described in “Ejecting the
sample holder” on page 3-10.

2.

Hold the sample plate with the bottom of the numbers
facing toward the analyzer (for standard 100-well plate)
and with the slanted underside of the plate facing to the
left (Figure 3-2).
4
74

85
75
65

86
76
66

PB100278

Figure 3-2 Loading the Sample Plate in a Voyager-DE
or Voyager-DE PRO
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3.

Slide the sample plate into the holder from the right side
until it snaps into place (Figure 3-2). The ball bearings on
the holder snap into the plate.
CAUTION
If the sample plate does not snap into place, it may be
inserted into the holder the wrong way, and it may jam
inside the instrument. Remove the plate, slide it into the
holder with the slanted underside of the plate facing to
the left and toward the back of the instrument, and snap
it into place.

WARNING
PHYSICAL INJURY HAZARD. Fingers can get caught
in the sample holder. To avoid injury, do not click Load
to retract the sample holder when your fingers are near
the sample holder.

3
4.

From the Sample Plate menu, select Load to retract the
sample plate and insert it into the main source chamber.
The Load/Eject Sample Plate dialog box (Figure 3-3) is
displayed.
.

Figure 3-3 Load/Eject Sample Plate Dialog Box
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NOTE: A Select Sample Plate Type dialog box is also
available from the Sample Plate menu in the Instrument
Control Panel. This dialog box allows you to select a
different plate type without ejecting the sample plate.

Sample plate
parameters

5.

In the Plate ID field, type 100 well.

6.

In the Plate Type field, click
, then select
100 well plate.PLT. For more information on .PLT files,
see the Voyager Biospectrometry Workstation User’s
Guide:
• Section 3.5.2, Editable-Configuration Plate (.PLT)
Types Provided with the System
• Section 3.5.3, Guidelines for Defining
Custom Plate Types
For more information on Plate IDs, see the Voyager
Biospectrometry Workstation User’s Guide, “Assigning
Plate IDs” on page 3-50.

7.

Select Use Mass Accuracy Optimizations, if desired, to
apply calibration corrections to the data acquired from the
plate. For information, see the Voyager Biospectrometry
Workstation User’s Guide, Section 3.4.2, Using the
Mass Accuracy Optimization Option.

8.

Click OK.
The sample plate is aligned as needed. For more
information, see the Voyager Biospectrometry
Workstation User’s Guide, “How the system aligns a
plate” on page 2-47.
It takes a minute or two for the sample plate to reach
the correct position. While the sample plate is moving,
the Load/Eject Status dialog box displays messages
about the status of the hardware.
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Voyager-DE STR

To load sample plates:
1.

Eject the sample holder as described in “Ejecting the
sample holder” on page 3-10.

2.

Hold the sample plate vertically, with the sample surface
facing to the right, and with the slanted underside of the
plate facing toward the back of the instrument.

3.

Slide the sample plate into the holder from the front until it
snaps into place (Figure 3-4). The ball bearings on the
holder snap into the plate.
CAUTION
If the sample plate does not snap into place, it may be
inserted into the holder the wrong way, and it may jam
inside the instrument. Remove the plate, slide it into the
holder with the slanted underside of the plate facing to
the left and toward the back of the instrument, and snap
it into place.

3

4

65

6

4

75

76

4

85

86
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Figure 3-4 Loading the Sample Plate in a
Voyager-DE STR
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WARNING
PHYSICAL INJURY HAZARD. Fingers can get caught
in the sample holder. To avoid injury, do not click Load
to retract the sample holder when your fingers are near
the sample holder.

4.

From the Sample Plate menu, select Load to retract the
sample plate and insert it into the main source chamber.
The Load/Eject Sample Plate dialog box (Figure 3-5) is
displayed.
.

3

Figure 3-5 Load/Eject Sample Plate Dialog Box

NOTE: A Select Sample Plate Type dialog box is also
available from the Sample Plate menu in the Instrument
Control Panel. This dialog box allows you to select a
different plate types without ejecting the sample plate.
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Sample plate
parameters

5.

In the Plate ID field, type 100 well.

6.

In the Plate Type field, click
, then select
100 well plate.PLT. For more information on .PLT files,
see the Voyager Biospectrometry Workstation User’s
Guide:
• Section 3.5.2, Editable-Configuration Plate (.PLT)
Types Provided with the System
• Section 3.5.3, Guidelines for Defining
Custom Plate Types
For more information on Plate IDs, see the Voyager
Biospectrometry Workstation User’s Guide, “Assigning
Plate IDs” on page 3-50.

7.

Select Use Mass Accuracy Optimizations, if desired, to
apply calibration corrections to the data acquired from the
plate. For information, see the Voyager Biospectrometry
Workstation User’s Guide, Section 3.4.2, Using the
Mass Accuracy Optimization Option.

8.

Click OK.

3

The sample plate is aligned as needed. For more
information, see the Voyager Biospectrometry
Workstation User’s Guide, “How the system aligns a
plate” on page 2-47.
It takes a minute or two for the sample plate to reach
the correct position. While the sample plate is moving,
the Load/Eject Status dialog box displays messages
about the status of the hardware.
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This chapter contains the following sections:
4.1

Setting the Instrument Control Panel ............... 4-2

4.2

Acquiring the Standard .................................. 4-10

4.3

Evaluating Data ............................................. 4-20

For a detailed description of acquiring spectra, see the Voyager
Biospectrometry Workstation User’s Guide, Chapter 6, Acquiring
Spectra from the Instrument Control Panel.
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4.1 Setting the
Instrument Control Panel
To set the Instrument Control Panel for acquisition, you:
•
•
•
•

Start the Instrument Control Panel
Load an instrument settings (.BIC) file
Set Data Storage parameters
Select the sample position

4.1.1 Starting the Instrument Control Panel
Double-click the Instrument Control Panel icon to start the
Instrument Control Panel (Figure 4-1).

4

Figure 4-1 Instrument Control Panel
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Checking system
pressure

From the View menu, select System Status.
Before acquiring data, allow the pressure in the Source
Chamber (BA1) and Mirror Chamber (BA2) to reach:

Source Chamber
(BA1) Pressure
(Torr)

Mirror Chamber
(BA2) Pressure
(Torr)

Voyager-DE and
Voyager-DE PRO

Less than 10–

Less than 10 –6

Voyager-DE STR

Less than 5×10–7

Less than 5×10–8

Model

Readings from the vacuum gauges are displayed in the
System Status control page in the Instrument Control Panel.
See the Voyager Biospectrometry Workstation User’s Guide,
Section 2.11, Checking System Status and Pressures, for
more information.

4.1.2 Loading an
Instrument Settings (.BIC) File
Standard instrument settings (.BIC) files that have been
optimized for your system are provided with the software. You
can use these files as a starting point to acquire data and
optimize them as needed.

Loading an
instrument
settings (.BIC) file

To load a .BIC file:
1.

Select Open Instrument Settings from the File menu
in the Instrument Control Panel. The Open dialog box is
displayed (Figure 4-2).
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Figure 4-2 Open Dialog Box
Standard instrument setting (.BIC) files provided are
located in the C:\VOYAGER\DATA\FACTORY directory.
2.

Select the following instrument settings (.BIC) file:
• ACTH_Linear.BIC—If you are running in
Linear mode
• ACTH_Reflector.BIC—If you are running in
Reflector mode

Hint: If the .BIC file you need is not visible, click the
scroll bar to view more instrument setting files.

4
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The .BIC file is loaded. The currently loaded .BIC file
name is displayed in the title bar of the Instrument
Control Panel (Figure 4-3).
Loaded
.BIC file name

Data Storage
Control page

Active Sample
Position

Mass
Range

Instrument Settings
Control page

Figure 4-3 Instrument Control Panel with ACTH_Linear.BIC File Loaded
If the Instrument Settings control page is not displayed, select
Instrument Settings from the View menu.

Changing
instrument
settings

Instrument settings in a standard .BIC file are optimized for the
mass range shown on the Instrument Settings control page. It
is not typically necessary to change settings.
If you find you need to optimize instrument setting parameters,
see the Voyager Biospectrometry Workstation User’s Guide,
Section 5.4, Optimizing Instrument Settings Parameters.
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Saving a new .BIC
file

If you change any of the optimized instrument settings
parameters, do not overwrite the .BIC file loaded on your
system. Select Save As Instrument Settings from the File
menu and type in a new file name.

4.1.3 Setting Data Storage Parameters
To set Data Storage parameters:
1.

If the Data Storage control page is not displayed, select
Data Storage from the View menu.
The Data Storage control page is displayed
(Figure 4-4).

4

Figure 4-4 Data Storage Control Page

2.

Click
stored.

to select a directory in which all data files will be

Hint: To keep instrument settings and data organized,
create a Getting Started directory.
3.
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Type the file name CalMix2.

Setting the Instrument Control Panel

4.

Select Autosequence Filenames if you want the
software to determine the next available sequential file
name.

5.

In the Sample Description/Comment text box, enter text
that will be saved with the data file. This step is optional.
For more information on data storage, see the Voyager
Biospectrometry Workstation User’s Guide, “Setting
Data Storage parameters” on page 6-14.

4.1.4 Selecting Sample Position
To select sample position, do the following:
1.

If the Manual Laser/Sample Positioning control page is
not displayed, select Manual Laser/Sample Positioning
from the View menu.
The Manual Laser/Sample Positioning control page is
displayed (Figure 4-5) and reflects the .PLT file you
selected when you loaded the sample plate.

2.

Select the standard position to analyze by doing any of
the following in the Active Position box:
• Type a position number
• Select a position number from the drop-down list
• Single-click on a sample position
You can hear the sample transport moving inside the
mass spectrometer, and can see the sample plate
moving on the video monitor. It takes a few seconds for
the sample plate to move to the proper position.

NOTE: You can also use the Control Stick to select the
Active Position. See Figure 4-7 on page 4-11.
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Laser
intensity

Active
position

Laser
controls
.PLT
file loaded

Figure 4-5 Manual Laser/Sample Positioning Control
Page (Plate View) with a 100 Well Plate.PLT File
Loaded

3.

4
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From the Sample Plate menu, select Sample View to
display an expanded view of the selected sample position
(Figure 4-6).

Setting the Instrument Control Panel

Click-drag
scroll bars
to move
sample plate
under laser

Figure 4-6 Manual Laser/Sample Positioning Control
Page (Sample View)

4.

You can fine-tune sample plate position under the laser by
click-dragging the scroll bars or moving the control stick.
For more information, see the Voyager Biospectrometry
Workstation User’s Guide, Section 4.5.2, Adjusting
Laser Intensity and Selecting Sample Position.
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4.2 Acquiring the Standard
In this section, you will:
•
•
•
•

Adjust laser intensity
Start acquisition
Observe the signal
Check for peaks of interest

4.2.1 Adjusting Laser Intensity
Determining the
setting for your
system

Optimized laser settings are stored along with the optimized
instrument settings in the .BIC files provided with your system.
When you start the Instrument Control Panel, the laser
intensity is set to 1,800.
When you load a .BIC file, the laser setting saved in the .BIC
file is loaded.

Adjusting laser
intensity

4

To adjust laser intensity, click-drag the slider control or click
the fine and coarse buttons on the Manual Laser/Sample
Positioning control page (see Figure 4-5 on page 4-8). For
more information, see the Voyager Biospectrometry
Workstation User’s Guide, Section 4.5.2, Adjusting Laser
Intensity and Selecting Sample Position.
Hint: You can also set laser intensity by pressing
Ctrl+PgUp and Ctrl+PgDn on the keyboard. Pressing
these keys adjusts intensity in the same increments as the
fine laser control buttons.

Laser settings
used in this guide
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In this example, we will recommend certain laser intensities.
However, the recommended laser intensities may not be
appropriate for your system. Appropriate laser intensities vary
from system to system. Use the appropriate setting for your
system. For more information on laser settings, see the
Voyager Biospectrometry Workstation User’s Guide,
Section 5.4.2, Determining the Laser Setting.

Acquiring the Standard

4.2.2 Starting Acquisition
High voltage
warm-up for
improved mass
accuracy

For maximum mass accuracy, allow the high voltage power
supplies to warm up for a short period of time before
acquisition. Allowing the high voltage power supplies to warm
up before acquisition reduces variability in accelerating
voltages, and yields more reproducible ion flight times.
To turn on the high voltage power supplies, click
toolbar.

in the

NOTE: The high voltage power supplies are automatically
turned off after 60 minutes if the mass spectrometer is not
used. To change the Idle Time, see the Voyager
Biospectrometry Workstation User’s Guide, “High Voltage
Configuration” on page 2-38.

Starting
acquisition

Start acquisition, which starts the laser, by doing one of the
following:
• Click

in the toolbar.

• Select Start Acquisition from the Acquisition menu.
• Press the left button (the button farthest from the cable)
on the base of the control stick (Figure 4-7).

4
Move stick
up and down,
left and right
to adjust sample
position under
laser beam

Start/stop
data acquisition

PB100474

Figure 4-7 Control Stick
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4.2.3 Observing the Signal
During acquisition, a Live trace is displayed and updated in the
Spectrum window.
NOTE: On systems with Tektronix® oscilloscopes, no Live
trace is displayed. A Current trace is displayed after
acquisition is complete.
When acquisition is complete, you should see a Current trace
in the Spectrum window, similar to Figure 4-8, that includes
the following peaks:
•
•
•
•

Angiotensin—1296 Da
ACTH (18–39)—2,466.71 Da
ACTH (7–38)—3,660.17 Da
Insulin—5734.54 Da

4
Status bar
shows
acquisition
status

Figure 4-8 Current Trace in Spectrum Window
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If you do not see
signal

If you do not see any signal during acquisition, or if signal
intensity is low, move the sample plate under the laser until
you see a signal by doing one of the following:
• Click-drag scroll bars in the Sample View of Manual
Laser/Sample Positioning control page (see Figure 4-6
on page 4-9)
• Move the control stick knob to the left and right, or up and
down
When you find an acceptable signal, stop acquisition as
described below, then restart acquisition. It is good practice to
acquire actual data from one location in the same sample
position.

Stopping
acquisition

Acquisition continues until the number of shots specified in
Shots/Spectrum in instrument settings are collected.
Alternatively, you can stop acquisition when you observe an
acceptable signal by doing any of the following:
• Clicking

in the toolbar.

• Selecting Stop Acquisition from the Acquisition menu.
• Pressing the left button (the button farthest from the
cable) on the base of the control stick (see Figure 4-7 on
page 4-11).
CAUTION
Check to see if acquisition has already stopped
automatically before manually stopping. If acquisition has
stopped, the Spectrum window stops updating, and the
Instrument Control Panel status bar displays
“Acquisition-OFF” (it displays “Acquisition-ON” during
acquisition). See Figure 4-8 on page 4-12.
If acquisition has stopped and you restart acquisition with
the software or control stick, you will begin a new
acquisition and overwrite the Current spectrum.
The signal is acceptable when the peaks stabilize, and stop
expanding upward.
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4.2.4 Checking for Peaks of Interest
When acquisition is complete, check for peaks of interest:
•
•
•
•
•

Zooming to check
peak shape

Zoom in and check peak shape
Eliminating unwanted peaks
Check masses
Reacquire with lower laser intensity
Save the data file

To zoom in on the trace to examine peak shape:
1.

Position the cursor above and to the left of the first
peak of interest.

2.

Hold down the left mouse button and click-drag a box
around the area to zoom. Make sure to click-drag within
the Spectrum window (Figure 4-9).

Click-drag
a box around
these peaks

4

Figure 4-9 Zooming on Peaks
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The selected area is magnified.
You can also use the following zoom toolbar buttons:

3.

• Click

to Zoom in.

• Click

to Zoom out.

• Click

for Full Unzoom.

Examine the peaks and the right axis in the Current
Spectrum trace to determine if signal is saturated
(Figure 4-10).

Check for
signal
saturation

4

Figure 4-10 Evaluating the Spectrum–Saturated Signal and Broad Peaks
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NOTE: By default, the right axis is set to Display
Relative mode, which means it updates to reflect the
intensity of the most intense peak in the currently
displayed region of the trace. You can set the right axis
to display an absolute value if desired. For more
information, see Voyager Biospectrometry Workstation
User’s Guide, “Accessing graphic options” on
page 4-22.
Note the following about the example shown in
Figure 4-10:
• Intensity of the large peak is near 66,000,
indicating that the peak may be saturated.
• Peaks are broad. You can determine if peaks are
broad by calculating resolution as described on
page 4-21.
These conditions indicate that the laser power is too
high. Before collecting another spectrum at a lower
laser setting, eliminate noise peaks and check masses
to make sure the spectrum contains the peaks of
interest.

Eliminating
unwanted peaks

4

To eliminate unwanted peaks:
1.

From the Tools menu, select Peak Detection.

2.

In the Peak Detection dialog box, set the Minimum
Intensity to 20, then click OK.
Peaks with an intensity below 20 counts are no longer
labeled (Figure 4-11).
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Figure 4-11 Spectrum with Noise Peaks Eliminated

Checking masses

Reacquiring with
lower laser
intensity

With the noise peaks eliminated, you can more easily evaluate
remaining masses. Masses are within the expected range for
the standard, so you can reacquire using the same instrument
settings, but a lower laser intensity.
To reacquire with lower laser intensity:
1.

Adjust laser intensity between 1,100 and 1,200 using
the slider control on the Manual Laser Intensity/Sample
Positioning Control page (see Figure 4-5 on page 4-8).

2.

Start acquisition. See “Starting acquisition” on page 4-11
for information.

3.

Observe the signal.
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You should see a trace similar to the trace in
Figure 4-12. At a lower laser intensity, signal is no
longer saturated (examine the right axis) and peaks are
narrow and well resolved.

4
Figure 4-12 Spectrum Acquired at Lower Laser Intensity—Signal Not Saturated
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Saving the data
file

To save the data file:
1.

Click the Current trace.

2.

Click
in the toolbar or select Save Spectrum from
the Acquisition menu. The data is saved using the file
name specified in the Data Storage control page.
Information about the data file is displayed in the Data
Storage tab in the Output window at the bottom of the
Instrument Control Panel (Figure 4-13).

Figure 4-13 Data Storage Tab in Output Window

4
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4.3 Evaluating Data
To evaluate data:
• Examine the spectrum
• Check resolution
• Calculate signal-to-noise

4.3.1 Examining the Spectrum
Examine the spectrum to check that:
• Peaks of interest are present
• Peaks are sharp
• Peaks are well separated
Figure 4-14 show an acceptable signal in the Spectrum
window.

4

Figure 4-14 Acceptable Signal in Spectrum Window in Instrument Control Panel
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4.3.2 Checking Resolution
You can calculate mass resolution for up to four peaks in the
Current trace. The resolution values are displayed in the trace
next to the mass value for the peak.

Calculating
resolution

To calculate mass resolution:
1. Select the Current spectrum of interest.
2.

From the Tools menu, select Resolution Calculator.

3.

In the Resolution Calculator dialog box (Figure 4-15), set
the percentage of Peak Height at which to calculate
resolution. The default is 50%, which calculates the
resolution at the full width/half maximum of the peak
(FWHM).

4.

Set Minimum Peak Intensity. Signals below this intensity
are not included in the calculation.

4
Figure 4-15 Resolution Calculator
5.

Type in up to four Mass/Charge values for which you
want to calculate resolution, or right-click-drag over peaks
in a Current spectrum trace to select values.

6.

For each Mass/Charge, enter the window for calculation
(±AMU).
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NOTE: To label isotopes, set the ±AMU value low
enough to prevent the calculation windows for each
isotope peak from overlapping. If the calculation
windows overlap, only the highest peak is labeled.
7.

Click OK.
The peaks are labeled with (RXXXX) next to the peak
mass, where XXXX is the resolution (Figure 4-16).

Resolution
result

4
Figure 4-16 Resolution Calculator Results in Instrument Control Panel—
Example of Good Resolution
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Determining if
resolution is
acceptable

Compare the resolution you obtain to the following table
(Table 4-1).
Table 4-1

Compounds
<2,000 Da
Resolution

Rating

Resolution Rating Scale

Compounds 2,000 Compounds 5,000
to 5,000 Da
to 25,000 Da
Resolution

Rating

Resolution

Rating

Compounds
>25,000 Da
Resolution

Rating

500

Not
acceptable

250

Not
acceptable

500

Not
acceptable

50

Acceptable

1,500

Acceptable

400

Acceptable

700

Acceptable

100

Good

2,000

Good

500

Good

900

Good

>200

Very good

2,500

Very good

>600

Very good

1,000

Very good

____

____

4.3.3 Calculating Signal-To-Noise
Calculating
signal-to-RMS
noise ratio

To calculate a signal-to-RMS noise ratio:
1. Select the Current spectrum of interest.
2.

From the Tools menu, select S/N Calculator.

3.

In the Signal to Noise Calculator dialog box (Figure 4-17),
set the Baseline Region by doing one of the following:
• Type in From and To values
• In the Spectrum window, right-click-drag over the
baseline area you want to use in calculating
signal-to-noise ratio.

4.

Type in up to four Mass/Charge values for which you
want to calculate signal-to-noise ratio, or right-click-drag
over peaks in a Current spectrum trace to select values.
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Figure 4-17 Signal to Noise Calculator

5.

For each Mass/Charge, enter the window for calculation
(± AMU).

NOTE: To label peaks, set the ± AMU value low enough
to prevent the calculation windows for each peak from
overlapping. If the calculation windows overlap, only
the first peak is labeled.
6.

4

Click OK.
The peaks are labeled with (SXXX) next to the peak
mass, where XXX is the signal-to-noise ratio.
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Signalto-noise
result

Figure 4-18 Example of Good Signal-To-Noise

After determining that the data is acceptable for the standard,
create a calibration file (described in the next chapter) that you
will add to instrument settings and use to acquire the sample.
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5 Creating a
Calibration
(.CAL) File

5

This chapter contains the following sections:
5.1

Overview .......................................................... 5-2

5.2

Opening the Data File in Data Explorer ............. 5-3

5.3

Processing Before Calibrating........................... 5-4

5.4

Calibrating ........................................................ 5-6

5.5

Exporting the Calibration (.CAL) File............... 5-10
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5.1 Overview
Before you analyze samples (described in Chapter 6,
Acquiring Sample Spectra) generate a calibration (.CAL) file
from the standard you acquired in the previous chapter. Before
acquiring the sample, you will add this calibration (.CAL) file to
your instrument settings.
The section describes the procedures necessary for you to
calibrate data. In this chapter, you will:
• Open the data file in the Data Explorer software
• Perform procedures before calibrating to enhance mass
accuracy
• Calibrate
• Export the calibration (.CAL) file

5
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5.2 Opening the Data File in the
Data Explorer Software
Opening from
Instrument
Control Panel

When acquisition is complete, you can open the most recently
acquired data file by clicking
in the Instrument Control
Panel toolbar.
The data file opens in the Data Explorer software.

Opening from
Data Explorer
software

If you are calibrating using a previously acquired data file, do
the following in the Data Explorer window:
1.

If the Data Explorer window is not visible, double-click
on the icon in the Windows task bar at the bottom of the
desktop.

2.

From the File menu in the Data Explorer window, select
Open.

3.

Navigate to the Getting Started directory and select
CALMIX2.DAT.
The CALMIX2.DAT file is displayed in the Data Explorer
window (Figure 5-1).

5
Figure 5-1 CALMIX2.DAT in the Data Explorer Window

Voyager™ Biospectrometry™ Workstation Getting Started Guide

5-3

Chapter 5

Creating a Calibration (.CAL) File

5.3 Processing Before Calibrating
To optimize mass accuracy, do the following before calibrating:
• Baseline-correct
• Smooth
• Deisotope

Creating macros
to combine
processing
functions
Processing

Baseline correcting

You can create macros that perform the multiple functions
listed above, and then start the macro with one mouse click.
For information, see the Data Explorer Software User’s
Guide, Section 6.7, Using the Macro Recorder.

To process:
1.

In the Data Explorer window, click on the spectrum
trace.

2.

From the Process menu, select Baseline Correction.
The spectrum is baseline-corrected. For more
information, see the Data Explorer Software User’s
Guide, Section 5.8.2, Using Baseline Correction.

Smoothing

3.

From the Process menu, select Noise Filter/Smooth.
The Noise Filter/Smooth dialog box (Figure 5-2) is
displayed.

5
Figure 5-2 Noise Filter/Smooth Dialog Box
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4.

Select Default for the smoothing method, then click OK.
The spectrum is smoothed and displayed with an RSM
trace label. For more information, see the Data Explorer
Software User’s Guide, Section 5.7, Noise
Filtering/Smoothing.

Deisotoping

5.

Make sure peaks are isotope-resolved (typical if you are
analyzing Reflector mode data).
If peaks are not isotope resolved, skip to Section 5.4,
Calibrating.
If peaks are isotope resolved, select Peak Deisotoping
from the Peaks menu.
The Deisotoping dialog box (Figure 5-3) is displayed.

Figure 5-3 Deisotoping Dialog Box

6.

For this example spectrum, specify H for Adduct and
C6H5NO for Generic Formula.

7.

Click OK.
The spectrum is reduced to a monoisotopic centroided
plot of the monoisotopic masses. For information, see the
Data Explorer Software User’s Guide, Section 3.4,
Deisotoping a Spectrum.
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5.4 Calibrating
In this example, you will calibrate using the ACTH (18–39)
peak at 2,466.71 Da, and the Insulin peak at 5,734.50 Da.
To calibrate the deisotoped spectrum:
1.

From the Process menu, select Mass Calibration and
then select Manual Calibration.
The Manual Mass Calibration dialog box is displayed
(Figure 5-4).

Figure 5-4 Manual Mass Calibration Dialog Box
2.

Click

and select the VOYAGER.REF calibration

reference file.

5
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3.

Enter Reference Matching and Calibration Criteria.

NOTE: For descriptions of calibration parameters, see
the Data Explorer Software User’s Guide, Section 5.3,
Manual Calibration.

Manually matching
peaks

4.

To manually select the reference mass for a peak,
right-click-drag over the peak of interest.
The Select or Create Reference Peak Information
dialog box (Figure 5-5) is displayed and lists all masses
in the selected reference file. The entry highlighted is
the nearest match in the calibration reference file to the
selected peak.

Figure 5-5 Select or Create Reference Peak
Information Dialog Box

5
5.

Check that the select mass is correct for the selected
peak.
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If it is not correct, select the correct mass, then click OK
to accept the highlighted reference mass for matching,
and add it to the Peaks Matched list.
The Manual Mass Calibration dialog box is displayed
again (see Figure 5-4 on page 5-6) with the observed
mass and the reference mass you selected displayed in
the Peaks Matched list.

Hint: You can sort the list of matches by clicking on the
column header buttons. You can display complete
information about a reference mass by double-clicking
on the mass.

Eliminating data
points

6.

Repeat step 4 through step 5 until the desired peaks are
in the matched list.

7.

To eliminate unacceptable data points from the calibration,
do either of the following:
• Select the data point (mass) in the Peaks matched
list, then click Delete Selected Match.
• Click Eliminate Fit Outlier. The software deletes
the data point from the calibration with the largest
calibrated Fit Error (difference between the
calibrated mass and the reference mass) as
reported in the Output Window (Figure 5-4).
To clear the entire list, click Delete Entire List.

Plotting

8.

To apply the calibration constants to the spectrum
displayed, click Plot.
The spectrum is calibrated and displayed with an
MC trace label. The calibration statistics are displayed
in the Result tab of the Output window (Figure 5-5).

5
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Applying new
constants to the
data file

To apply the calibration constants to the data, click Apply
Calibration. The current spectrum is calibrated and
displayed with an MC trace label. The calibration constants
are saved with the spectrum.

After calibration

Figure 5-6 shows the deisotoped spectrum after calibration.
Note that the trace labels reflect the processing that has been
performed on the data. For more information, see the Data
Explorer Software User’s Guide, Section 2.4.10, Viewing
Trace Labels.

Trace labels

Figure 5-6 Deisotoped Spectrum After Calibration

For more information on creating an external .CAL file, see the
Data Explorer Software User’s Guide, Section 5.3, Manual
Calibration.

5
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5.5 Saving (Exporting) the
Calibration (.CAL) File
To export the calibration for use during acquisition:

5

5-10
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1.

From the File menu, select Export, then select
Calibration. This function exports the last applied
calibration constants to a stand-alone .CAL file.

2.

In the Save As dialog box, type ACTH_Linear_Cal or
ACTH_Reflector_Cal as the name for the exported
.CAL file.

3.

Click Save.

Chapter
6 Acquiring
Sample Spectra

6

This chapter contains the following sections:
6.1

Modifying Instrument Settings for
Sample Acquisition ........................................... 6-2

6.2

Acquiring Sample ............................................. 6-3
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6 6.1 Modifying Instrument Settings
for Sample Acquisition

To modify instrument settings for sample acquisition:

Saving .BIC file

6-2

Applied Biosystems

1.

In the Instrument Settings control page, click Manual.

2.

In the calibration section, select External File, then select
the ACTH_Linear_Cal or ACTH_Reflector_Cal file that
you created in Chapter 5, Creating a Calibration
(.CAL) File.

3.

Save this new Instrument Settings (.BIC) file as
ACTH_Linear_Cal.BIC or ACTH_Reflector_Cal.BIC.

Acquiring Sample

6.2 Acquiring Sample
Setting Data
Storage
Selecting sample
position
Starting
acquisition

6

Specify Data Storage location as described in Section 4.1.3,
Setting Data Storage Parameters.
Select the sample position for the mock standard as described
in Section 4.1.4, Selecting Sample Position.
To start acquiring, select Start Acquisition from the
Acquisition menu, or click
.
Acquisition starts and continues until the number of
Shots/Spectrum specified in Spectrum Acquisition on the
Instrument Settings control page is collected, or until you
select Stop Acquisition from the Acquisition menu or click
again.

Adjusting laser
intensity
During
acquisition

If necessary, increase or decrease the laser intensity as
described in Section 4.2.1, Adjusting Laser Intensity, until you
observe acceptable signal intensity.
During acquisition:
• The Live trace in the Spectrum window updates to display
the spectrum that results from each laser shot.

NOTE: If your system includes an oscilloscope, the
Current Spectrum does not display a trace until
acquisition is complete. The spectra that result from
each laser shot are displayed on the oscilloscope
screen.

• The system averages all spectra acquired since you
started acquisition.
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When acquisition is complete, the software displays the data
in a Current trace in the Spectrum window (see Figure 6-1).

6

Figure 6-1 Sample Spectrum

Evaluating data

Evaluate the data as described in Section 4.3, Evaluating
Data.
You can also examine the data in the Data Explorer software.
See the Data Explorer Software User’s Guide for information.
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axis 4-16
Acquiring data, Instrument Control
Panel
checking for peaks of interest 4-14
resolution, calculating during 4-21
sample 6-1
signal-to-noise ratio, calculating
during 4-23
standard 4-10
starting acquisition 4-11
stopping acquisition 4-13
ACTH
mass 4-12
ordering 1-6
ACTH_Linear.BIC 4-4
ACTH_Reflector.BIC 4-4
Active position, selecting 4-7
Alpha-cyano-4-hydroxycinnamic acid
preparing 3-3
when to use 3-3
Axes, changing scale on right axis 4-16

CAL files, exporting from DAT 5-10
Calibrating mass, automatic (Mariner
data only)
error, fit 5-8
Calibrating mass, manual
error, fit 5-8
fit outliers, eliminating 5-8
peak matches, clearing list 5-8
peak matches, sorting 5-8
results 5-8
Calibration
high voltage warmup before
calibration 4-11
increasing accuracy 3-8
manual 5-6
mass accuracy 3-8
processing before to improve mass
accuracy 5-4
standard location on plate 3-8
Calibration constants
exporting 5-10
extracting from DAT file 5-10
Calibration file, exporting 5-10
Calibration reference file (REF)
viewing contents of 5-7
CHCA, see Alpha-cyano-4hydroxycinnamic acid
Checking for peaks of interest 4-14
Chemical hazards 1-5, 3-3
Control stick
diagram 4-11
moving position on sample
spot 4-11
starting acquisition 4-11, 4-13
stopping acquisition 4-13

B
Baseline correction 5-4
Basics of the system 1-2
BIC files
loading 4-3
location 4-4
name displayed in Instrument
Control Panel 4-5
saving 4-6
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opening data file 5-3
starting 2-4
Data file
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opening from Data Explorer 5-3
opening from Instrument Control
Panel 5-3
opening in Data Explorer 5-3
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consequence of loading wet
plate 3-10
time needed 3-9
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overview 1-4
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External calibration file, creating 5-10

F
File name 4-6
Fit Error, calibration 5-8

H
Hardware, initializing 2-3
High voltage
standby time period 4-11
warmup before calibration 4-11

I
Initializing hardware 2-3
Instrument Control Panel
loading sample plates 3-10
parts of 4-5
starting 2-3
Instrument settings file (BIC)
in Control Panel 4-2
loading 4-3
location 4-4
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saving 4-6
Insulin
mass 4-12
ordering 1-6
Ion source warmup 4-11
Isotopes, resolution labels not
displayed for all peaks 4-22
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Labels
MC 5-8
Laser
safety information xviii
UV radiation warning xiii
Laser intensity
adjusting 4-10
too high 4-16
Linear mode 4-4
Log sheet 3-8

Oscilloscope initialization 2-2
Output window
calibration statistics, displaying 5-8
Output window, Data Storage tab 4-19

M
MARINER.REF
viewing masses in 5-7
Mass accuracy
and location of standard 3-8
improving 3-8, 4-11, 5-4
troubleshooting 3-8
Mass Accuracy Optimizations 3-14,
3-17
Mass spectrometer, loading sample
plates 3-10
Matrix
mixing with sample 3-7
preparing 3-3
storage conditions 3-2
MC in spectrum header 5-8, 5-9
Monoisotopic peak
deisotoping a spectrum 5-5
reducing trace to 5-5

N
Noise Filter/Smooth 5-4
Noise, eliminating 4-16

P
Password 2-2
Peak detection, eliminating unwanted
peaks 4-16
Peak labels
resolution 4-22
signal-to-noise 4-24
Peak matches
clearing list 5-8
sorting 5-8
Peak shape
checking 4-14
description of acceptable 4-20
Peaks
checking for 4-14
eliminating noise 4-16
zooming 4-14
Pipette tips, recommended 1-6
Plate View 4-8
PLT files, selecting 3-12, 3-15
Powerup sequence 2-2
Pressure, vacuum 1-4, 4-3

R
Reference masses, calibration
see also Calibration reference file
(REF)
displaying list of 5-7
selecting 5-7
Requirements for experiment 1-5
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Right axis, changing scale 4-16
RSM trace label 5-5

S
Safety information, laser xviii
Safety standards xvi
Sample
acquiring 6-1
guidelines for good
crystallization 3-8
guidelines for preparation 3-2
loading on plates 3-8
log sheet 3-8
mixing with matrix 3-7
preparing 3-7
selecting position to analyze 4-7
volume to load on plate 3-8
Sample plate
consequence of loading wet
plate 3-10
drying time 3-9
handling 3-8
loading in mass spectrometer 3-10
loading sample 3-8
moving position under laser 4-11
proper orientation 3-11, 3-14
selecting type 3-12, 3-15
spotting sample and standard
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using outer rows 3-8
volume of sample to load 3-8
Sample View 4-9
Saving a data file 4-19
Signal
if you do not see 4-13
observing 4-12
Signal, saturated
checking 4-16
number of counts 4-16
Signal-to-noise ratio
acceptable 4-20
calculating during acquisition 4-23
calculating for live data 4-23
labels not displayed for all
peaks 4-24
results 4-24
Sinapinic acid, when to use 3-3
Smoothing 5-4
Spectra
acceptable 4-20
starting acquisition 4-11, 4-13
stopping acquisition 4-13
Spectrum window
right axis, displaying Absolute
counts 4-16
Spotting sample 3-8
Standard
acquiring 4-10
spotting next to sample 3-8
Standby mode, high voltage power
supplies 4-11
Startup sequence 2-2
Stopping acquisition 4-13

U
User Name 2-2
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Vacuum pressure 1-4
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VOYAGER.REF 5-6
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W
Warning statements 1-5, 3-3
Warnings, safety
high voltage xiv
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symbols on system vii
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Z
Zooming in the Spectrum window 4-14
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